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Software for Commercial Software Freeware

Writing  

Calculating

Presenting

MS-Word

MS-Excel

MS-Powerpoint

OpenOffice

LibreOffice

Office -Online (Word, Excel,é)

Google Docs

Literature

Citation  managing

Endnote

(Reference Manager)

Myendnoteweb

Sciwheel (https://sciwheel.com ) 

Zotero

Bibus

Mendeley

Pdf-editing Adobe Acrobat Prof. Pdf-XChange Editor

Image Processing Adobe -Photoshop

Adobe Illustrator

both : (Vers. CS2:free)

Gimp , Irfanview , Paint.net

InkScape

Image Analysis ImageJ, Fiji , CellProfiler

Curve  fitting

Data analysis

GraphPad-Prism

Sigmaplot , MS-Excel 

CurveExpert

Cytometry CellQuest , DIVA, éCytExpert

Cytoflow

X-ray structure  analysis Chimera , Rasmol , RasTop

CN3D (iCN3D)

Sequence analysis Snapgene , VectorNTI

CloneManager

CLC Sequence Viewer

UGENE, SnapGene Viewer , SerialCloner , ApE

Network visualization Cytoscape

7Johannes A. Schmid, Inst. of Vascular Biology and Thrombosis Research

https://sciwheel.com/
http://www.mendeley.com/


Download-links for  software

Å Online Office packages : 

- OnlineWord , Excel, Powerpoint ..: https://www.office.com  (You need  a free  MS-account: hotmail  or  outlook ) - 

GoogleDocs , Google sheets  etc: https://docs.google.com  é

- OnlyOffice : similar  to Word.. https://www.onlyoffice.com  

Å LibreOffice : https://de.libreoffice.org  

Å OpenOffice: https://www.openoffice.org/de /

Å Mendeley : https://www.mendeley.com/  .. If  you  donôt have Endnote

Å MyEndnoteWeb : https://www.myendnoteweb.com/  - free  alternative to Endnote

Å Sciwheel : https://sciwheel.com  

Å pdf -xchange  editor : https://www.tracker -software.com/products    

Å free  (older ) versions  of Adobe Photoshop and Adobe Illustrator : 

https://www.computerbild.de/download/Adobe -Photoshop -CS2-Vollversion -8040793.html

https://www.computerbild.de/download/Adobe -Illustrator -CS2-Vollversion -8043129.html  

Å Gimp : https://www.gimp.org  , Inkscape : https://inkscape.org/  

Å Fiji -version of ImageJ : https://fiji.sc  

Å CellProfiler : http://cellprofiler.org  

Å Graphpad  Prism (trial  version ): http://www.graphpad.com/scientific -software/prism/  
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Offline alternatives to MS-Office
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Download-links for  software II

Å Cytometry: Flowing  Software : http://www.uskonaskel.fi/flowingsoftware/

Cytexpert : https://www.beckman.com/coulter -flow -cytometers/cytoflex/cytexpert  

Cytoflow : https://cytoflow.github.io  

Å 3D-molecular structure  viewer  ChimeraX : https://www.cgl.ucsf.edu/chimerax/   

CN3D (from NCBI): https://www.ncbi.nlm.nih.gov/Structure/CN3D/cn3d.shtml

Å Sequence analysis (DNA, RNA, protein, plasmids):

SnapGene Viewer : http://www.snapgene.com/products/snapgene_viewer/

UGENE: http://ugene.net

Serial Cloner : http://serialbasics.free.fr/Serial_Cloner.html

Å Network visualization: Cytoscape : http://www.cytoscape.org

Å LinRegPCR for  realtime PCR ( qPCR) analysis : 

http://www.hartfaalcentrum.nl/index.php?main=files&sub=LinRegPCR

Å  Plagiarism  check: VIPER: http://scanmyessay.com/  
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Content of the 1st session

ÅMS-Word

ÅEndnote ( citation  manager  software )

ÅMendeley  (free  citation  manager  software )

ÅSciWheel Workspace 

ÅPubMed database : professional search  and link to citation  

manager
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Microsoft -Word 
From 2003 to 2007 -2010-2013-2016é Microsoft 365
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Clicking the arrow at the 

lower right end of an entry 

opens a detailed submenu



Some Hints  for  MS-Word 

ÅThere  are three  different ENTER commands :

- ENTER alone : new paragraph

- SHIFT / ENTER: new line ( e.g. in bulleted  lists )

- CTRL (Strg) / ENTER: new page

ÅUse rather  tables  instead  of tabulators  (e.g. when  you  write  a CV; you  

can make  the  lines  invisible)

ÅYou can copy  all different kinds  of files  into  a Word-file  and maintain  

the  original file  in the  background  (e.g. Excel graphsé) by OLE (Object  

Linked  Embedding )

ÅYou can generate  hyperlinks  to other  files  or  websites

ÅUse ăInsert  symbol ò for  Greek letters  instead  switching  to Symbol font

(this  maintains  the  symbols  if  you  are switching  the  font  later )

ÅYou can apply  the auto -correction  feature  for  frequently  used  text 

(including  formats  such as symbols : e.g. ăNFò is replaced  by ăNF- Bˁò or  

TNF is replaced  by TNF )h
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Finding  a command

Åusing  the  search  window  in the  

toolbar , you  can find most  

commands  quickly : 
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Using the auto-correction  feature

14

File Menu > Options > 

Proofing > Autocorrection

- you can delete 

unwanted entries (e.g. 

DNA> DANN)

- you can specify that it 

shouldnót capitalize letters 

after a period (e.g. 

abbreviation p53)

- you can define your own 

abbreviation-autotext 

entries (even in a 

formated manner 

including Greek symbols 

e.g. NF > NF-kB)

- you can define auto-text 

entries, e.g. that Ăphosñ is 

always extended to 

Ăphosphorylationñ
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Customizing Word

15

There is a fast access toolbar that can be 

customized
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Customizing Word

16

There is a fast access toolbar that can be 

customized
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Customizing Word
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Right-clicking on the menu, 

allows customizing each tab.
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Language and spell checking settings
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Language is usually automatically set. 

You might consider to set it specifically to US-English 

(e.g. if you are submitting a manuscript to a US-journal)
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Spell-Checking in MS-Word

19

mistakes are underlined in 

red; right-clicking on the 

wrong word opens a 

context menu: 

suggestions for the right 

word ïor: option to add 

the unknown word to the 

dictionary

(the latter makes sense to 

add scientific terms to the 

dictionary). Itós 

recommendable to use 

this feature for correct 

scientific writing.
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You find your custom 

dictionary at: 

C:\Users\username\AppData\Ro

aming\Microsoft\UProof:

CUSTOM.DIC

(can be transferred to other PC)

Grammar check 

can be helpful, too



The Thesaurus: Shift-F7 (or right -click in a word)
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Ågives you suggestions for synonyms

(quite convenient, when you write a longer text, where you 

donôt want to use the same words again and again)



Other useful 
features: Count 
words, characters
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Compare and merge documents 
(if  several people work on the same document)



The Reviewing Mode of MS-Word: As Reviewer
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1. Click  on the 

reviewing  tab

2. Activate  the Ătrack  

changes  modeñ 

(Änderungen 

nachverfolgen )

3. Type your  changes  

into  the document

(deleted  text will 

appear  struck -

through ) , changes  

are marked  in a 

different colour  

(according  to the 

reviewer -computer  

settings )

4. If necessary : add 

comments

5. You should  de-

activate  the track -

changes  mode again  

at the end
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The Reviewing Mode of MS-Word II: 
accept or reject changes done by the reviewer

24

right-click onto a 

change and either 

accept or reject a 

modification 
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- or use the 

Accept button



Insert a Table of Contents

25

When you define headings in your 

document , these can be used for 

inserting a table of contents

Headings: usually:

Ctrl +1 (Heading 1)

Ctrl +2 (Heading 2)..
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Insert a Table 
of Contents
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Insert a Table of Contents
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ĂCtrl + clickñ on an 

entry lets you jump 

to the respective 

page of the 

document

Table of content 

can be updated by 

clicking on the top 

(or right-clicking 

into it)



Copying Excel Graphs into  Word (as Excel file )
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In Excel: click on the graph and copy it (Ctrl-C)

> in Word (Home tab): click: Paste special: and paste as Excel object
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Opening Excel Graphs in Word (as Excel file )
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Double clicking on the 

graph in the Word file 

opens a small Excel 

Window (the frame 

changes):

> you can change the 

appearance of the graph 

(as in Excel)

> you can also go into the 

data and change the data 

that is shown etc.

This procedure can be done with every file that allows OLE (Object Linked embedding)



The different tabs and toolbars
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The different tabs and toolbars
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Developments since MS-Office 2013

ÅUsability on tablets and convertibles

ÅStrong connection to Onedrive the cloud -solution of Microsoft (with 

hotmail or outlook account)

ÅNew licensing strategy: Microsoft365: always newest Office : (Word, 

Excel, Powerpoint, Outlook, OneNote, Access, Publisher): rental for 

students and academics possible ðbut not supported by our 

University for employees (due to data safety issues).

ÅMicrosoft365 is free for most students  with some restrictions at the 

Med.Univ Vienna (does not include the 1TB Onedrive space)

Åpdfôs can be converted  in Word documents  (format  maintained , 

editable )

Å Integration of online videos  or  pictures , recording  of the screené
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Add-ins within Word 2013 and later
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Apps in Word 2013
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Mendeley Add-In for citations

Adding of figure legends

Johannes A. Schmid, Inst. of Vascular Biology and Thrombosis Research



36

You can open the same document twice 

(e.g. to work on 2 different positions 

simultaneously)

(Dragging the window to the left margin of 

the monitor will scale it exactly to the left 

half of the monitor >> and vice versa on the 

right side)
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The Navigation Window
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Some features since Word 2016
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Å Better sharing options

Å Authors can work simultaneously on the same document on the cloud (Onedrive)  
Ą You can work with others on a manuscript or grant proposal simultaneously and see 

changes in real time: BUT: frequent error messages with large or complex documents

Changes done by co-authors 

can be checked and previous 

versions can be restored

Chat function for co-authors 
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ĂSearchñ Button

> Help function that initiates the command immediately
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Smart Look up function  within a document (by right-clicking a word)

Hand-written equations can be automatically converted:

Insert > Equation > Ink Equation
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Hand-written equations can be automatically converted:

Insert > Equation > Ink Equation
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Inserting of 3D models
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Some features of Office 365 users:
Opening of Word-files, which had been received as 
email attachment:
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Translations within a document
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Working with images in Office files
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Double click on an image and 

perform brightness/contrast 

adjustments, changes of 

colors or removal of 

backgroundé
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Working with images in Office files

46Johannes A. Schmid, Inst. of Vascular Biology and Thrombosis Research



The ñResearcherò function
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Speech recognition (Dictating text)
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Included into the Start-tab of the latest version without the need of an Add-in
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Newest functions  in Office 365

ÅTransparency of images

ÅIntegration of animated  3D 

models
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Google Docs for text documents 
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Good MS-Word-alternative 

for shared documents 

(joint publications, grant 

applications etc.)

version history



Google Docs features
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upper right corner:



Google Docs features
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Google Docs features
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Google Docs Add-ons
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Many useful extensions:

- Sciwheel

- Paperpile

- Thesaurus



OnlyOffice: www.onlyoffice.com
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Online Office 

Package, which 

seems to combine 

advantages of 

GoogleDocs and 

WordOnline

https://www.onlyoffice.com/


OnlyOffice: www.onlyoffice.com
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OnlyOffice: www.onlyoffice.com
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OnlyOffice: www.onlyoffice.com
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PubMed Literature  Search
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Keywords can be combined with logical operands (AND, OR, NOT ï in capital letters), including brackets, and 

the search can be narrowed to certain fields such as title, author name, publication type (e.g. review) using 

squared brackets ... (AND can be omitted ï at is set as default)

Registering  for  a free account  (MyNCBI) allows  saving  searches  ï and performing  searches  with  a 

collection  of keywords  automatically  every  day 

(with  results  sent  by email)



PubMed search tags

60

Affiliation [AD] 

All Fields [ALL] 

Author  [AU] 

Comment Corrections 

Corporate Author [CN] 

EC/RN Number [RN] 

Entrez Date [EDAT] 

Filter [FILTER] 

First Author  Name [1AU] 

Full Author Name [FAU] 

Grant Number [GR] 

Investigator [IR] 

Issue [IP] 

Journal Title [TA] 

Language [LA] 

Last Author  [LASTAU] 

MeSH Date [MHDA] 

MeSH Major Topic [MAJR] 

MeSH Subheadings [SH] 

MeSH Terms [MH] 

NLM Unique ID [JID] 

Other Term [OT] 

Owner  Pagination [PG] 

Personal Name as Subject [PS] 

Pharmacol. Action MSH Terms [PA] 

Place of Publication [PL] 

Publication Date [DP] 

Publication Type [PT] 

Publisher Identifier [AID] 

Secondary Source ID [SI] 

Subset [SB] 

Substance Name [NM] 

Text Words [TW] 

Title [TI] 

Title/Abstract [TIAB] 

Transliterated Title [TT] 

UID [PMID] 

Volume [VI]
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Å when you are signed in, search results are highlighted.

Å Phrases or exact word combinations can be searched with quotation marks 

(e.g. Ăprostate cancerñ)

Å Filters can be applied (left side)
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PubMed Literature  Search
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Browser extension: Pubmed Impact factor: for filtering according to Impact factor



Using [ ti ] to search for  title words
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when you are signed in, search results are highlighted.

Phrases or exact word combinations can be searched with 

quotation marks 

(e.g. Ăprostate cancerñ)
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Advanced search: 

additional options, 

search history 

(search #1, #2 ...), 

the single searches 

can be combined 

(e.g. #1 AND #2) ï 

and the resulting 

search (#3) can be 

set as automatic 

search (Ăcreate 

alertñ). In this way, a 

collection of 

keywords can be 

searched 

automatically every 

day ï and the results 

sent by email

Johannes A. Schmid, Inst. of Vascular Biology and Thrombosis Research



65

Advanced search: 

additional options, 

search history 

(search #1, #2 ...), 

the single searches 

can be combined 

(e.g. #1 AND #2) ï 

and the resulting 

search (#3) can be 

set as automatic 

search (Ăcreate 

alertñ). In this way, a 

collection of 

keywords can be 

searched 

automatically every 

day ï and the results 

sent by email
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Email of the search results
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The downloaded file can be directly opened with Endnote (or other citation software)

In this  way many  search  results  can be imported  at once  into  the reference  software .
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Display settings can be changed:

Abstract display: contains ĂLink-Outsñ to the article on the journal 

website
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Sciwheel ï web-based citation  manager 
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Å Browser and Word add-on available (as well as Google-Docs add-on)

Å Projects: can be shared

Å Makes suggestions of new literature based on the existing projects 

Å License available for our university

https://sciwheel.com/

https://sciwheel.com/


Sciwheel ï web-based citation  manager 
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Import references to Sciwheel
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Import references to Sciwheel from 
Pubmed with  Browser extension
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Search data base with  Sciwheel
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Working with references in Sciwheel
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You can open attached pdf-files and highlight text, make comments etc. 



Word Plug-in for Sciwheel
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Google Docs Plug-in for Sciwheel
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Google Docs Plug-in for Sciwheel
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Writing a research paper with  co-authors

ÅMake sure  you  are using  the same text  software  ð ideally  

one  which  allows  working  simultaneously  on a shared  

document

ÅMake sure  you  are using  the same citation  management  

software : Sciwheel allows  to share  projects  with  your  co-

authors

ÅAgree  on a common  software  for  generating  figures  

(recommendation : use freeware  such as Gimp for  bitmap  

images  ð and Inkscape  to create  scalable  vector  graphics  ð 

so that  all co-authors , students  etc. can use that  software ) 
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AI tools for scientific literature

¶https://sciwheel.com> create projects for specific topics > AI will find 

suggestions for further literature fitting to the topics in the project

¶https://www.semanticscholar.org/

¶https://www.chatpdf.com/

¶https://typeset.io/resources/introducing-copilot-ai-assistant-explains-research-

papers/

https://typeset.io

¶https://elicit.org

https://sciwheel.com/
https://www.semanticscholar.org/
https://www.chatpdf.com/
https://typeset.io/resources/introducing-copilot-ai-assistant-explains-research-papers/
https://typeset.io/resources/introducing-copilot-ai-assistant-explains-research-papers/
https://typeset.io/
https://elicit.org/


Writing scientific manuscripts

ÅProfessional translation of German phrases to English: 

Åhttps://www.deepl.com/translator

Apps for Windows, Mac, Android and iOS available

(e.g., mark text in any application > press Ctrl + CC > marked text is 

copied to a DeepLwindow and translated ςand you can then insert the 

translated text in your document)

ÅImproved writing: https://www.deepl.com/write#en/

https://www.deepl.com/translator
https://www.deepl.com/write#en/


Endnote 

ÅThere  are Plug-Ins for  MS-Word and Open Office ð so that  you  do 

not have to type the  citations  ð and it  also takes  over  the  

formating  and the  numbering  of the  citations

ÅYou can search  PubMed directly  from  Endnote or  Ref.Manager  

ÅFrom most  of the  Journals there  are export  links available  for  these  

programs

ÅYou can use these  programs  to generate  your  own  specific  

literature  database

ÅURLs (weblinks ) and pdf -Links  can be added  to the  references

81

Software for scientific reference handling (citation manager)
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Endnote 

82

sortable list references can 

be opened by 

double clicking
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Connections to Databases (Pubmed)

83

you can either search the 

internet database (PubMed) 

ï or your local database for 

references.

Search tags are ĂAuthorñ 

(e.g. Muster-T), Title, Yearé

local database view

remote database view

local + remote database view (default)
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Endnote- Journal Styles

84

Formatting as requested by 

the editors of the Journals
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ĂOutput stylesñ ï in the Edit Tab



Endnote- Journal Styles

85

Formatting as requested by 

the FWF in grant application
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Styles can be edited (e.g. to add doi-hyperlinks)



Link to MS -Word

86

This Add-In is automatically added to 

MS-Word after installing Endnote

Å The reference  is inserted  with  the  Journal style ð 

and a reference  list is added  at the  end of the  

document  (in the  Journal style as well ); this  can be 

done  immediately  (ăinstant formatting ò on) or  after 

clicking : ĂUpdate Citations and Bibliographyñ 

Å When you  add  citations  later  (e.g. in between  other  

citations ), the  program  automatically  updates  the  

numbering  of the  references  in the  text (ăCite  while  

you  writeò feature )

Johannes A. Schmid, Inst. of Vascular Biology and Thrombosis Research



Link to MS -Word
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Å From  a Word -file containing  Endnote references  an 

Endnote library  can be extracted , which  can then  

be extended  (e.g. if  2 authors  work  on a 

manuscript ) Ą you  donôt need  to  send Endnote 

libraries  via email to  co-authors , as they  are 

already  ăembedded ò into  the  Word file . 
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Groups and Smart Groups of references
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Smart Groups

(are automatically 

updated, when 

new references 

are imported)

Groups

within references
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A search command (e.g. using * as 

wildcard) can be converted to a 

Smart Group using ĂOptionsñ

Right-click on ĂMy Groupsñ can be 

used to create groups or smart 

groups
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Other Endnote features

Å direct import of pdf -files (even of whole folders): the Journal information is 

detected in the pdf -file and imported into the respective fields (>useful to import 

old literature folders and generating Endnote files directly from them) 

Å MyEndnoteWeb ða web version of the Endnote (to access endnote library files 

from other computers and to share citations) 

Å Auto -hyperlink between in -text citations and the bibliography in EndNote X4 and 

Microsoft Word 

Å Creating new groups by comparing, combining and suppressing existing groups. 

ÅWildcards (word stem plus ò*ó)can be added within search terms for better search 

results (e.g. NF* for all versions of NF -kappa B) 

Å pdf -preview window (editable)
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Importing  of pdf-files into  Endnote
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Pdf-fileós or folders 

containing pdf-files 

of articles can be 

dragged directly to 

the Endnote window 

frame to be imported
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The preview panel 
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References can be 

quicky edited in this 

tab

3 tabs: 

Reference, Preview, pdf

The ĂPreviewñ tab shows the 

style of the citation, when the 

reference is inserted into a 

Word document
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The pdf-preview and editing  tab
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highlighting

commenting

open in a new window

email the pdf-file
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Endnote Full -Text Search feature
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Open URL Path: currently  not active  for  MedUni Wien

Pdf-file is automatically 

downloaded to the library (if the 

university has access to the full 

text)
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Further features

Å library sharing with up to 14 colleagues

Åresearch community in EndNote online

ÅMac
®

and Windows
®

compatibility ðinstall on up to 3 computers of 

either type

ÅBackground synchronization 

ÅMore than 6,000 reference styles

ÅReference types such as interview, podcast, conference paper and 

press release

ÅPlug-in for adding citations to Microsoft
®

PowerPoint
®

slides 

(Windows only)

ÅOnline storage of pdf -files: unlimited 

(X5 and X6: 5 GB, X4: 2GB)
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Free online Endnote: MyEndnoteWeb
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http://www.myendnoteweb.com
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Limitation: 

Rather simple search

(not for: Title, authoré)

http://www.myendnoteweb.com/


Free online Endnote: MyEndnoteWeb
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http://www.myendnoteweb.com
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Plug-in available for inserting references into Word

http://www.myendnoteweb.com/


Find appropriate journals for your manuscript
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http://www.myendnoteweb.com
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Mendeley-Freeware alternative to Endnote
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http://www.mendeley.com/
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http://www.mendeley.com/


Mendeley Web Importer  and 
Plugins for  Word and OpenOffice
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pdfós can be dragged to the program window and are recognized; they can 

also be edited in the software (highlighting, adding notesé)
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Other Citation Managers
Å Zotero: https://www.zotero.org/

Å Papers (Mac and Windows): http://www.papersapp.com/

Recommendation: When co -authoring a manuscript find an agreement on the citation software before 

starting to write. 
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